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1. Instructions for using Adobe Reader 
All FWF forms are compatible with Adobe Reader (Version 6.0 and higher), which can be 
downloaded free of charge at http://get.adobe.com/reader/.  
 
The fields to be completed can be highlighted in order to enable the user to identify them 
more easily. 
Instructions:  

• Open the file Application form.pdf (or National research partner.pdf, etc.) 
• In the menu bar, open the Edit menu and then choose the Preferences item (in Mac 

OS, this item can be found in the Reader menu). A dialog box will then appear. 
• Choose Forms in the list box under Categories (on the left-hand side of the dialog 

box). 
• In the area to the right, activate the check box "Show border hover color for fields" 

under Highlight color. This action will highlight all fields in light blue. You can also 
deactivate the check box if you do not wish to highlight the fields in the form. Below 
the check box, you can also choose the highlight color for fields as desired. Click OK 
to confirm your selection. 

Navigating forms: 

Keyboard: Use the Tab key to move forward from one field to the next, and SHIFT + Tab to 
move backward to the previous field in the form. 
Mouse: Simply click on the desired field. 

Field types 

The form contains various field types: 
Text fields: These are fields in which you can enter any of the characters on your keyboard 
(e.g., German title, Applicant, etc.) 
Number fields: These are defined fields in which only numbers can be entered (e.g., 
percentages, codes for scientific disciplines, etc.) 
Date fields: These fields only allow entries in the following date format: dd.mm.yyyy (e.g., 
date of birth, etc.) 

Drop-down list boxes: These fields provide a limited number of options for you to choose 
from. Click on the drop-down arrow at the right of the field in order to open the list and 
choose the desired item (e.g., Funding application type, Sex, etc.). 

Check box:  

Mouse: Simply click on the check box. 

Keyboard: The check box can be selected using the Tab key and activated using the Space 
bar. 

Save/Print 

Under the File menu, choose the item Save as… in order to save the (partly) completed 
form; choose Print to print out the form. 

http://get.adobe.com/en/reader/�
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2. How to fill out the application form for a Elise Richter-Position 

The application package for the Elise Richter Position includes the application form, the 
programme-specific data, and the cost spreadsheet. For instructions on filling out the cost 
spreadsheet, please refer to page 4. Another form is available for the entry of co-authors and 
should be submitted with the application package in any case. If there is no co-author, please 
simply submit an empty form. 

There are also additional forms for national research partners, for international cooperation 
partners and for the entry of equipment. Those forms are to be filled out as necessary.  

Please read the instructions provided on the form carefully and note the explanations and 
definitions provided below. 

Application form: Page 1 

Field name Explanation 

Funding application 
type: 

Choose "Elise Richter-Position" in the drop-down menu. 

Call  This field does not need to be filled out for this programme. 
Co-applicant This field does not need to be filled out for this programme. 
 

Application form: Page 2 

Field name Explanation 

Title/Acad. degree Please enter your full academic title. 
Completion date of 
doctoral studies 

In the case of multiple doctoral degrees, please enter the date on 
which you completed your most recent doctorate. For medical 
studies: Date of completion of doctoral studies.  

Social security 
number (AT) 

Please enter the first four digits of your Austrian social security 
number here. If you do not have an Austrian social security 
number, simply enter "9999". 

Birth dates of 
children 

If you have children, please enter their dates of birth here. 
Children include biological children, stepchildren, adopted 
children, etc. who are under the age of 14. If you have more than 
four children, please indicate all of their  names and birth dates in 
your curriculum vitae. 

Highest academic 
position/degree 

Please choose the category which best describes the highest 
position or degree you have attained. In this context, it is 
necessary to distinguish between your academic position/degree 
and your actual current activities, which are covered in the next 
question. Should none of the categories match your 
position/degree, please describe it as specifically as possible in 
the "Other" field (maximum: 60 characters including spaces). 

Highest current Please choose the category which best describes your position. 
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professional position This question refers to the highest professional position you 
currently hold. In this context, it is necessary to distinguish 
between your actual activities and your highest academic position 
or degree, which was covered in the previous question. Should 
none of the categories match your current professional position, 
please describe it as specifically as possible in the "Other" field 
(maximum: 60 characters including spaces). 

 

Application form: Page 3 

Field name Explanation 

Research institution Please indicate the research institution at which you currently 
work. This research institution does not have to be the same as 
the one at which the Elise Richter project is to be carried out (to 
be indicated in Module 3, page 8). 

Mailing address These address fields only need to be filled out in cases where the 
applicant does not have a postal address at a research institution. 
The applicant's name will be entered automatically and cannot be 
deleted. 

 

Application form: Page 4 

Field name Explanation 

Duration Minimum duration: 12 months; maximum: 48 months. 
Independent 
applicant 

This field does not need to be filled out for this programme. 

Percentage of 
requested funding to 
be consumed at the 
research institution 

This field does not need to be filled out for this programme. 

Share of work time 
(%) 

For full-time positions (40 hours per week), please enter 100% in 
this field. For part-time positions, the percentage must be at least 
50%. 

Project keywords Please enter a maximum of six keywords in English which describe 
your project as completely and as accurately as possible. 

Scientific disciplines 
to which project is 
related 

Using the four-digit codes defined by Statistics Austria 
(http://www.fwf.ac.at/de/applications/v-richter.html), please indicate 
the main scientific discipline as well as a maximum of three 
additional scientific disciplines to which your project is related. In 
addition, please enter percentages to indicate the extent to which 
each scientific discipline is involved in your project. The 
percentages entered must total 100%. 

http://www.fwf.ac.at/de/applications/v-richter.html�
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Application form: Page 5 

Field name Explanation 

Preliminary project(s): If a project can be described as a preliminary project but has 
not yet been completed at the time of application, please 
indicate the name of the project here and enclose a 
preliminary report of results with your application documents. 

Application form: Page 7 

Field name Explanation 

Letter of support from 
research institution 

Applicants are required to obtain the signature of the head of 
the research institution at which the Elise Richter position is to 
be based. If the project is to be carried out without an affiliation 
with a research institution, then no signature is required here. 

 

Instructions for filling out the "Breakdown of Costs" Excel spreadsheet: 

Please enter the costs to be funded in the "Breakdown of Costs" spreadsheet. 

The fields highlighted in light gray can be filled in. The subtotals and overall totals are 

calculated automatically and cannot be changed. As parts of the spreadsheet are locked, 

only certain functions can be used (e.g., insert/delete rows). It may be necessary to add rows 

if you request funding for additional project personnel. If that is the case, please do the 

following: 

• Select all of Row 7 or Row 8 by clicking on the row header. 

• Press the right mouse button and choose "Insert". This will insert an additional row 

above Position No. 02 or 03. Repeat this procedure until the spreadsheet contains 

the desired number of rows. You can also delete those rows by choosing "Delete".  

• It will then be necessary to ensure that the position numbers are numbered 

consecutively (01, 02, etc.).  

 
To save the breakdown of costs as a PDF file, please do the following: 

• Click on the "Office" button and choose the "Save as…" menu item.  

• Then choose PDF or XPS. 

• This will open a dialog box in which you can define the name of the file, then click 

Publish. 

In order to import the spreadsheet into a Word file, please do the following: 

• Launch Word and change the page layout to landscape format ("Page layout" tab / 

"Orientation" button / "Landscape" option). 
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• To insert the spreadsheet into the Word file, choose the "Insert" tab and the 

"Object" button, then choose the "Insert object" function. 

• This will open a dialog box where you can choose the "Create from file" tab. 

• Then choose the desired file under "File name:" and click OK. 
 
The breakdown of costs will then be imported into Word and can be integrated into 

applications which are not subject to formal requirements. 

 

Please also submit the file "Cost_Breakdown.xls" in electronic form along with the 
other files. 
 

 
Instructions for filling out the Elise Richter Programme cost spreadsheet:  
 

Personnel:  Please include your own position as project head; if the research project is to be 

carried out without any affiliation to an Austrian research institution, then choose the project 

type "FS" (=research subsidy without a contract of employment) and enter the corresponding 

amount of funding requested. 

 

The relevant funding amounts for various types of employment contracts can be found in the 

FWF's current schedule of personnel costs and salaries (based on annual rates for full-time 

employment). 

 

Funds for coaching or personnel development activities (up to EUR 2,000.00 per year) can 

be requested under "Other costs". 

 

The Lump-sum grant for children is not requested in the "Breakdown of Costs" spreadsheet, 

but added by the FWF on the basis of the information provided in the application (page 2 of 

the application forms / curriculum vitae). 

 

For other types of costs, please refer to the application instructions. 

 

The maximum amount of funding which can be requested is EUR 15,000.00 per year 

(including personnel costs for project employees). The amount requested for a given year 

may exceed this limit as long as the overall amount does not exceed EUR 15,000.00 per 

year (e.g., the overall amount for three years must not exceed EUR 45,000.00). 
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Forms for enclosures – Data entry sheet for international cooperation 
partners 

Field name Explanation 

Data entry sheet for 
international cooperation 
partners 

Please complete a separate sheet for each international 
cooperation partner relevant to the project, regardless of 
whether or not the partner is to receive funding from the 
project.  

Specification of 
cooperation 

Individual cooperation arrangements refer to those which are 
directly relevant to the project but do not belong to European 
or international cooperation programmes such as COST, 
EUREKA, the EU Framework Programme, etc. 
 

Cooperation partners 
from developing 
countries 

This field only needs to be filled in if the international 
cooperation partner is to receive financial support from the 
FWF project (and belongs to the category "Least Developed 
Country"  or "Other Low Income Country" according to the 
OECD'S current DAC List; see 
www.oecd.org/dac/stats/daclist) 
 

 


